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Safety precautions  

The expansion card must be installed and operated only by professionals who have taken part 

in professional training on electrical operation and safety knowledge, obtained the certification, 

and been familiar with all steps and requirements for the installing, commissioning, operating, 

and maintaining, and can prevent all kinds of emergencies. 

Before installing, removing, or operating the expansion card, read the safety precautions 

described in this manual and the variable-frequency drive (VFD) operation manual carefully to 

ensure safe operation. 

We are not responsible or liable for any physical injuries or device damage caused due to your 

neglect of the safety precautions described in this manual and the inverter operation manual. 

⚫ You need to open the inverter housing to install or remove the expansion card. 

Therefore, you must disconnect all power supplies of the inverter and ensure that the 

voltage inside the inverter is safe. For details, see the description in the inverter 

operation manual. Severe physical injuries or even death may be caused if you do not 

follow the instructions. 

⚫ Store the expansion card in a place that is dustproof and damp-proof without electric 

shocks or mechanical pressure. 

⚫ The expansion card is electrostatic sensitive. Take measurements to prevent 

electrostatic discharge when performing operations involving it. 

⚫ Tighten the screws up when installing the expansion card. Ensure that it is firmly fixed 

and properly grounded. 

 



HD2-E-PLC Auto Station Software  Contents 

ii 

 Contents 

Safety precautions ................................................................................................................... i 

Contents ................................................................................................................................... ii 

1 Product confirmation ........................................................................................................... 1 

2 Product overview.................................................................................................................. 2 
2.1 Expansion card introduction .......................................................................................... 2 
2.2 Models ........................................................................................................................... 2 
2.3 Terminal layout............................................................................................................... 3 
2.4 Status indicators ............................................................................................................ 5 

3 Secondary development platform ...................................................................................... 7 
3.1 Auto Station introduction ................................................................................................ 7 
3.2 PLC program download interface .................................................................................. 7 
3.3 How to edit programs on the Auto Station ..................................................................... 8 

4 Auto Station programming interfaces .............................................................................. 12 
4.1 Importing and exporting interfaces .............................................................................. 12 
4.2 Interfaces for digital inputs and outputs ....................................................................... 14 
4.3 Interfaces for analog inputs and outputs ..................................................................... 17 
4.4 Interfaces for control commands and function commands .......................................... 19 
4.5 Interfaces for setting function parameters ................................................................... 22 
4.6 Interfaces for viewing function parameters and inverter status ................................... 23 
4.7 PLC-defined fault interface .......................................................................................... 27 
4.8 Interfaces for writing data ............................................................................................ 28 
4.9 Interfaces for monitoring PLC card data ...................................................................... 29 
4.10 RUN/STOP switch and PLC card running status ...................................................... 30 
4.11 DP/CANopen/PN communication channel ................................................................ 31 
4.12 RS485 communication and power-outage saving ..................................................... 35 

5 Programming cases ........................................................................................................... 37 
5.1 For PLC card digital input/output terminals ................................................................. 37 
5.2 For terminal-based running/fault control ...................................................................... 37 
5.3 For multi-step setting and running ............................................................................... 38 
5.4 For RS485 communication .......................................................................................... 40 

Appendix 1 D elements for exchange between the PLC card and inverter ..................... 43 

Appendix 2 Function codes for the PLC card (Group P27) ............................................... 55 
  

 



HD2-E-PLC Auto Station Software  Product confirmation 

-1- 

1 Product confirmation 

Check the following after receiving HD2 series inverter Auto Station programmable expansion 

card: 

⚫ Whether the expansion card is damaged. 

⚫ Whether the received expansion card is the one you purchase according to the bar 

code label on the PCB. 

⚫ Whether all the following items are contained in the product package: 

One expansion card, one tie buckle, one tie, one M3 screw, and one manual 

If the expansion card is damaged, a wrong model is delivered, or some items are missing, 

contact the supplier in a timely manner. 

Confirm the environmental requirements for application. 

Table 1.1 Environmental requirements 

Item Requirement 

Working temperature -10–50°C 

Storage temperature -20–60°C 

Relative humidity 5%–95% 

Other weather conditions 
No condensation, ice, rain, snow, or hail. 

Solar radiation < 700 W/m2 

Air pressure 70–106kPa 

Vibration and impact 5.9m/s2 (0.6g) at the sine vibration of 9 Hz to 200 Hz 
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2 Product overview 

2.1 Expansion card introduction 

HD2 series inverter Auto Station programmable expansion card (hereinafter called PLC card) 

works with the inverter to replace small-size PLC in certain application cases. We develop the 

Auto Station to perform secondary program development on the PLC card, supporting three 

programmable languages, including the instruction language (IL), ladder diagram (LD), and 

sequential function chart (SFC). The PLC card has 16K step user program storage space and 

8K words data storage space (D elements) for easy development. After completing programs 

on the Auto Station, you can upload the programs through the mini-USB interface to the PLC 

card for running. The PLC card transfers data to the inverter to control inverter running and 

modify parameters. In addition, the PLC card provides the power-outage saving function, 

which will save the values about 1K words of the M/S/D/C elements in case of power outage if 

you have specified the saving range on the Auto Station. You can use the RS485 channel for 

network communication. The standard Modbus protocol has been embedded into the PLC 

card so that the master/slave switchover can be performed on the Auto Station. The PLC card 

also provides the DP/CANopen/PN card with the PZD channel, through which data can be 

transferred from the DP/CANopen/PN card to the PLC card for secondary programming or 

from HD2 to the PLC card and then transferred to the DP/CANopen/PN card.  

When the PLC card works with the inverter, all the external I/O terminals of the inverter can be 

invoked by the PLC card, enriching the I/O points of the PLC card. 

 

 

2.2 Models 

The following is a HD2 expansion card model example: 

HD2 - E - PLC 

① ②    ③  

Figure 2.1 Expansion card model example 

Table 2.1 Expansion card model description 

No. Field Description 

① Series name HD2 Series 

②  Type E: External 

③ Expansion card type PLC: PLC card 
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2.3 Terminal layout 

The terminal layout of the PLC card is as follows: 

 

COM COM PS1 PS2 PS3  PRO2A PRO2C 

PW 24V PS4 PS5 PS6   PRO1A PRO1C 

Figure 2.2 Terminal layout of the PLC card 

The following table describes the functions of the terminals. 

Table 2.2 Terminals of the PLC card 

Category Symbol Name Function 

Power supply 

PW 
External power 

supply 

To provide input digital working power 

from external to internal. 

Voltage range: 12–24V 

PW and +24V are short connected by 

default. 

24V 
Internal power 

supply 
Internal output power supply, 100mA 

Common 

terminal/ground 

COM 
Common terminal 

of +24V 

Common terminal of +24V. If PS1 is 

connected, COM indicates PS1 is 

connected. 

GND Analog ground Reference zero potential of +10V 

PE 
Protective 

earthing terminal 
Protective earthing terminal 

Digital input 

PS1 Digital input 1 1. Internal impedance: 4kΩ 

2. Accept 12–30V voltage input 

3. Bi-directional input terminal 

4. Max. input frequency: 1kHz 

5. Both source and sink inputs are 

allowed, but the input types must be the 

same 

PS2 Digital input 2 

PS3 Digital input 3 

PS4 Digital input 4 

PS5 Digital input 5 

PS6 Digital input 6 

Analog input and 

output 
AI1 Analog input 1 

1. Input range: AI1 voltage and current 

range: 0–10V, 0–20mA 

2. Input impedance: 20kΩ during voltage 

input; 250Ω during current input 

3. Voltage or current input is set through 

the jumper. 

4. Resolution ratio: When 10V 

PE 485- 485+ GND AI1 AO1  
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Category Symbol Name Function 

corresponds to 50Hz, the min. resolution 

ratio is 5mV 

5. Deviation: ±1% when the input 

reaches full the measurement range at 

25°C 

AO1 Analog output 1 

1. Output range: 0–10V voltage or 

0–20mA current 

2. Voltage or current output is set 

through the jumper. 

3. Deviation: ±1% when the input 

reaches full the measurement range at 

25°C. 

Relay output 

PRO1A 
NO contact of 

relay 1 

1. Contact capacity: 2A/AC250V, 

1A/DC30V 

2. Unable to function as high frequency 

switch output 

PRO1C 
Common contact 

of relay 1 

PRO2A 
NO contact of 

relay 2 

PRO2C 
Common contact 

of relay 2 

Communication 

485+ 
RS485 

communication 

terminal 

RS485 communication port, which can 

be set as the master or slave through the 

Auto Station. It is differential signal 

output. Whether to connect the 120Ω 

resistor of RS485 is set through the 

jumper. 
485- 

Note:  

⚫ The jumpers used for connection are at the side of the PE, 485-, 485+, GND, AI1, and 

AO1 terminal block.  

⚫ AI and AV are the current and voltage selection options of analog input AI1 and the 

connection to jumper J2 determines the input type.  

⚫ AIO and AVO are the current and voltage selection options of analog output AO1 and the 

connection to jumper J5 determines the output type.  
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⚫ The symbol "120" indicates the 120Ω resistor, which can be connected to jumper J1. By 

default, J1 connects to NC, J2 connects to AV, and J5 connects to AVO. 

 

Figure 2.3 PLC card 

2.4 Status indicators 

The dial switch SW1 on the PLC card can control the running and stop of programs on the 

card. The PLC card provides five status indicators to represent the status. 

Table 2.3 Status indicators 

Indicator No. Represents Function 

LED1 
PWR power supply indicator 

(green) 

It is steady on when the PLC card is 

powered on. 

LED3 
COMM communication 

indicator (green) 

It is steady on when the PLC card is 

establishing connection to the 

control board. 

When the PLC card properly 

connects to the control board, it 

turns on for 0.5 second and turns off 

for 0.5 second in a regular way. 

When the PLC card is disconnected 

from the control board, it is steady 

off. 

LED4 ERR fault indicator (red) 

When a fault occurs, it turns on for 

0.5 second and turns off for 0.5 

second in a regular way. 

When there is no fault, it is steady 

off.  

The fault can be queried through the 

Auto Station. 
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Indicator No. Represents Function 

LED5 
PWR power supply indicator 

(green) 

It is steady on when the PLC card is 

powered on. 

LED6 
RUN running status 

indicator (green) 

It is steady on when the PLC 

program runs. 

It is steady off when the PLC 

program stops. 
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3 Secondary development platform 

3.1 Auto Station introduction 

We have developed the Auto Station as the secondary development platform of PLC cards. 

Currently, Auto Station V1.41 is used as the secondary development platform of the PLC card. 

You are recommended to download Auto Station V1.41 or later. 

If you have successfully installed the Auto Station, double-click the Auto Station. The interface 

is displayed, as shown in the following: 

 

Figure 3.1 Auto Station interface 

3.2 PLC program download interface 

If you want to download programs to the PLC card through the Auto Station, you need to 

install the driver, use the mini-USB cable to connect the PLC card to the PC. If the driver 

cannot be installed automatically, visit http://www.wch.cn/downloads/CH341SER_EXE.html 

and download the CH341SER.EXE file for USB-serial port driver of PLC card. If you cannot 

install it, contact us to obtain the driver and drive installation guide. 

After installing the driver, open the Auto Station. After creating a project, choose PLC 

http://www.wch.cn/downloads/CH341SER_EXE.html
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Communication > Connect, and choose Program Port Setting. Set related parameters. 

Generally, you only need to select the serial port (for example, COM5). 

 
Figure 3.2 Serial port setting for program download 

3.3 How to edit programs on the Auto Station 

1. After opening the Auto Station, choose File > New Project to create a project. Select IVC1L 

as the PLC type since the PLC card uses the structure of the IVC1L programmable controller 

developed by us. See the following figure. 

 

Figure 3.3 Creating a project 

You can also choose Tool > Options… to change the default editor (program editing 



HD2-E-PLC Auto Station Software  Secondary development platform 

-9- 

language), PLC type, and interface language. The new project is an IVC1L project by default. 

See the following figure. 

 

Figure 3.4 Default option settings 

The interface that is displayed after the project creation is as follows: 

 

Figure 3.5 New project interface 
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The interface can be divided into five areas: 

Area ①: Menu and toolbar area. If you move the mouse over the toolbar area, the function of 

the corresponding tool is displayed. You can choose View > Instruction List/Ladder/SFC to 

change the program language. If a fault occurs, LED4 is blinking. You can choose PLC > PLC 

Info… to view fault information and choose PLC > Clear PLC Error Information to clear fault 

information. After the clearing, LED4 turns off. You can also choose Debug > Monitor to 

monitor variables. In monitoring mode, you can directly modify readable and writable elements 

to test programs. In addition, you can choose Help > Help Topic to view instruction 

descriptions and typical instances. 

Area ②: Project manager. If you want to use the RS485 function, you need to configure 

System Block > Serial Port. If you want to use the power-outage saving function, you need 

to configure System Block > Saving Range. If you want to monitor variables in monitoring 

mode, you need to configure Element monitoring table > EMT_1 or right-click the monitoring 

table to add element monitoring tables such as EMT_2 and EMT_3. If you want to download 

programs from the Auto Station to the PLC card or monitoring the running status, you need to 

configure PLC Communication > Connect, select a serial port, and set related port 

parameters. 

Area ③: Instruction tree. The instruction tree enables you to select instructions to edit 

secondary development programs. 

Area ④: Program editing area. You can edit programs in this area after selecting a program 

language. 

Area ⑤: Information output area, in which information such as download, upload, and 

monitoring information is output, for easy debugging and view. 

2. After completing a PLC program, you can download the program to the PLC card by clicking 

the download button on the toolbar. In case of power outage, the program is downloaded to 

the flash memory. When the SW1 switch is turned to RUN, you can control the running and 

stop of PLC programs by clicking the Run/Stop button on the toolbar of the Auto Station. 

3. When the PLC card runs a user-defined program, you can connect to the Auto Station 

through the mini-USB and choose Debug > Monitor to monitor PLC card variables. 

Double-click to choose Element monitoring table > EMT_1. In the window that is displayed, 

enter to-be-monitored variables in the Element Name column. If the variables are readable 

and writable, you can enter values in the New value column, right-click to choose Write 

Selected Element to change the element status. See the following figure. 
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Figure 3.6 Monitoring mode 

4. You can keep edited programs secret since the Auto Station also provides multi-level 

security measures, which are described in the following. 

Table 3.1 Security measures for user-defined programs 

Security measure Description 

Disabling formatting 

After formatting is disabled in the system block and the system block 

is downloaded to the PLC, the user-defined programs, system block, 

and data block in the PLC cannot be deleted by means of formatting. 

To enable formatting, download the new system block and enable 

formatting on the new system block. 

Download password Used to restrict download. 

Disabling upload 

If you select the option of disabling upload in the download dialog 

box as you perform download, you cannot perform upload regardless 

of whether you have the upload password. 

To enable upload, re-download user data, and select the option of 

enabling upload in the download dialog box. 

Upload password Used to restrict the upload function. 

Monitoring password Used to restrict the monitoring function. 

Program password 

You can set password to encrypt the main programs, sub programs, 

and terminated sub programs. After being encrypted, the program 

content cannot be viewed or edited. You can view and edit such 

encrypted programs only after entering the correct passwords. 

Encryption method: Right-click a program, choose Encrypt/Decrypt, 

enter a password, and confirm the password. The program is 

encrypted. 

Decryption method: Right-click an encrypted program, choose 

Encrypt/Decrypt, and enter the correct password. The program is 

decrypted. 
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4 Auto Station programming interfaces 

The PLC card integrates the secondary development function by using the Auto Station. In 

addition to the functions equipped with the PLC card, the entrance parameters required for 

Auto Station programming also include the PLC card hardware functions, inverter hardware 

functions, and inverter parameters. The output of Auto Station programming results is not only 

for the internal use of the PLC card, but also for other control purposes such as controlling the 

hardware output interfaces of the PLC card, the hardware output interfaces of the inverter, and 

the start and stop commands of the inverter. 

This chapter describes the relationship between the Auto Station secondary development, 

PLC card, and inverter interfaces (including hardware and software instructions), with a focus 

on Auto Station programming interfaces. The inverter related functions of Auto Station 

programming interfaces are valid only when the SW1 is in Run state. 

If not otherwise specified, all programming instructions use the LD programming system. 

4.1 Importing and exporting interfaces 

You can define programming interfaces and export the interface data to an Excel file. The 

Auto Station can provide programming interfaces by importing the Excel interface file. We 

provide a default programming interface file (an Excel file), which contains the interface names 

and corresponding PLC elements (D elements). You can use D elements for programming 

regardless of whether you import an Excel file. The default Excel file for HD2 programming 

interfaces is HD2_PLCcard_V100.xls. 

In the Excel file, each variable is named in the format of I/C_xx, in which I indicate the variable 

is sent to the PLC card through the inverter, while C indicates the variable is sent from the PLC 

card to the inverter. In a word, the initial letter identifies the variable type. 

The PLC card provides data storage elements of 8000 words, D0–D7999, in which 

D7400–D7699 are defined as the inverter data transfer interfaces that have special meanings 

corresponding to HD2 inverter parameters and therefore cannot be used as common storage 

elements and the other D elements can be used as required. 

The method of importing programming interfaces is as follows: 

1. Double-click Global variable table on the Project Manager bar. In the opened global 

variable table, choose File > Import Global Variable. Then select HD2_PLCCard_V100.xls. 
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Figure 4.1 Importing global variables 

The imported global variable table is similar to the following: 

 
Figure 4.2 Global variable table 

When programming, you can directly use the variable names in the global variable table or 

use the corresponding D elements (after D elements are written, the system automatically 

replaces the D elements with corresponding variable names). The following is an example of 

saving the set frequency of the inverter to the element D100: 

 

Figure 4.3 Programming example of using the global variable table 

If the global variable table is not imported, which indicates the table is empty, you can only use 
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D7400–D7599 for programming. The following is an example of saving the set frequency of 

the inverter to the element D100: 

 

Figure 4.4 Programming example of not using the global variable table 

2. You can define a global variable table by yourself. That is, fill in the global variable table and 

export the global variable table. Then the user-defined global variable table is saved. You can 

import this global variable table when creating a project. Note that a variable name in the 

global variable table cannot exceed 16 ASCII characters. 

Note:  

⚫ The prerequisite to import and export the global variable table is that the global variable 

table window has been opened (to open the window, double-click the global variable 

table in the project manager).  

⚫ A limit is imposed on the number of variables in the global variable table that can be 

downloaded to the PLC card. If there are too many variables defined in the global 

variable table, the use is not affected, but some or all variables cannot be uploaded (at 

this time, only the method described in this section can be used for import). 

⚫ After importing the global variable table, you need to choose View > Symbol 

Addressing so that the D elements are displayed normally. Otherwise, the D elements 

are displayed like "Dxxxx". 

4.2 Interfaces for digital inputs and outputs 

In addition to embedded I/O points, the PLC card can use inverter I/O points the since the card 

is inserted into the inverter control board. (The specific I/O point quantity depends on the 

actual product development.) You can define and use virtual I/O points, intermediate relays, 

and soft elements on the Auto Station based on needs. 

The following table lists the interfaces corresponding to the digital inputs and outputs of HD2 

and PLC card. 

Table 4.1 Interfaces corresponding to the digital inputs and outputs of the inverter and PLC 

card 

Auto Station 

interface 

variable name 

D/X/Y 

element 

Inverter 

function 

code 

Interface description 

I_DiState D7403 P17.12 I_DiState is an unsigned 16-bit number, which is 



HD2-E-PLC Auto Station Software  Auto Station programming interfaces 

-15- 

Auto Station 

interface 

variable name 

D/X/Y 

element 

Inverter 

function 

code 

Interface description 

read only. 

Each bit represents a unique digital input 

terminal on the inverter: 

Bit0: S1 

Bit1: S2 

Bit2: S3 

Bit3: S4 

Bit4: S5 (inverter I/O expansion card input 

terminal S5) 

Bit5: S6 (inverter I/O expansion card input 

terminal S6) 

Bit6: S7 (inverter I/O expansion card input 

terminal S7) 

Bit7: S8 (inverter I/O expansion card input 

terminal S8) 

Bit8: HDIA (for digital input) 

Bit9: HDIB (for digital input) 

Bit10–Bit15: Reserved 

C_SetDo D7626 / 

C_SetDo is an unsigned 16-bit number, which is 

readable and writable. 

Each bit represents a unique digital output 

terminal of the inverter: 

Bit0: Y1 

Bit1: HDO (for digital output) 

Bit2: Y2 (inverter I/O expansion card output 

terminal Y2) 

Bit3: RO1 

Bit4: RO2 

Bit5: RO3 (inverter I/O expansion card output 

terminal RO3) 

Bit6: RO4 (inverter I/O expansion card output 

terminal RO4) 

Bit7–Bit15: Reserved 

X0 X0 / Digital input terminal PS1 on the PLC card 

X1 X1 / Digital input terminal PS2 on the PLC card 

X2 X2 / Digital input terminal PS3 on the PLC card 

X3 X3 / Digital input terminal PS4 on the PLC card 

X4 X4 / Digital input terminal PS5 on the PLC card 
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Auto Station 

interface 

variable name 

D/X/Y 

element 

Inverter 

function 

code 

Interface description 

X5 X5 / Digital input terminal PS6 on the PLC card 

Y0 Y0 / Relay output terminal PRO1 on the PLC card 

Y1 Y1 / Relay output terminal PRO2 on the PLC card 

1. You can apply a bit contact instruction to I_DiState to perform terminal control. (The bit 

contact instruction is BLD, which can be found in the instruction tree.)  

 

Figure 4.5 Using a bit contact instruction 

This statement is used to get bit0 (16#0) of I_DiState, that is, to get the status of inverter input 

terminal S1. If the bit is 1, 1 is written to C_CTRL, which is described later, the inverter runs 

forward after setting P00.01=2 and P00.02=4 for the inverter. 

2. You can use the following instructions to divide I_DiState into 16 bit-elements. 

 

Figure 4.6 Word/bit conversion 

This program segment divides I_DiState into 16 bit-elements, which are M0–M15. You can 

operate the 16 bit-elements respectively. As shown in the figure, M0 is checked. When M0 is 

connected (I_DiState Bit0=1), 1 is written to C_CTRL, the inverter runs forward if correct 

channels have been set. 

3. After setting correct channel parameters P06.00–P06.04, P26.00–P26.02, and 

P26.04–P26.05, you can directly write a value to C_SetDo to control inverter output terminals. 

For example, run the following instruction: 

 

Figure 4.7 Controlling inverter output terminals 
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In the instruction, 2#1 represents 0000001 in binary format, writing it to C_SetDo, which 

means Bit0=1, indicates connecting the inverter output terminal Y1. 

4. For I/O terminals on the PLC card, directly edit programs on X0–X5 and Y0–Y1. 

 

Figure 4.8 Programming for PLC card I/O terminals 

The preceding instruction indicates that PRO1 (Y0) is connected when the PLC card PS1 (X0) 

terminal is connected. 

4.3 Interfaces for analog inputs and outputs 

The inverter control board and PLC card provide a total of seven analog inputs and outputs for 

Auto Station programming. (The number of analog input/output programming interfaces varies 

depending on the actual product development.) 

The following table lists the interfaces corresponding to the analog inputs and outputs of HD2 

and PLC card. 

Table 4.2 Interfaces corresponding to the analog inputs and outputs of the inverter and PLC 

card 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

I_AI1 D7407 P17.19 

0.00–10.00V/0.00–20.00mA. It is read only. 

inverter analog input terminal AI1, corresponding to 

0–1000/0–1000 

I_AI2 D7408 P17.20 

-10.00–10.00V. It is read only. 

inverter analog input terminal AI2, corresponding to 

-1000–1000 

I_AI3 D7409 P19.09 

0.00–10.00V/0.00–20.00mA. It is read only. 

inverter I/O expansion card analog input terminal 

AI3, corresponding to 0–1000/0–1000 

C_SetAO1 D7627 / 

0.00–10.00V/0.00–20.00mA. It is readable and 

writable. 

inverter analog output terminal AO1, corresponding 

to 0–1000/0–1000 

C_SetAO2 D7628 / 
0.00–10.00V/0.00–20.00mA. It is readable and 

writable. 
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Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

inverter I/O expansion card analog output terminal 

AO2, corresponding to 0–1000/0–1000 

C_SetAO3 D7629 / Reserved. 

C_Ai1Val D7633 P27.24 

0–10.00V/0.00–20.00mA. It is read only. 

To use the PLC card input terminal AI1, you need 

to configure SM172, SM173, and SM174. After the 

setting, the input value (corresponding to 

0–10000/0–10000) of the PLC card input terminal 

AI1 can be read from SD172 or D7633(C_Ai1Val). 

The value is also synchronized to P27.24. 

For SM172, the value 1 indicates enabling input, 

while the default value 0 indicates disabling input. 

For SM174, the value 1 indicates current input, 

while the default value 0 indicates voltage input. 

SD173 specifies the sampling count. 

C_Ao1Val D7634 P27.25 

0–10.00V/0.00–20.00mA. It is readable and 

writable. 

To use the PLC card input terminal AO1, you need 

to configure SM178 and SM179. After the setting, a 

value (corresponding to 0–10000/0–10000) can be 

written to SD178 to enable AO1 to output current or 

voltage. The value is also synchronized to P27.25. 

For SM178, the value 1 indicates enabling output, 

while the default value 0 indicates disabling output. 

For SM179, the value 1 indicates current output, 

while the default value 0 indicates voltage output. 

Note: D7634(C_Ao1Val) only has the display 

function and cannot be used for programming. That 

is, writing a value to D7634(C_Ao1Val) does not 

change the output value of AO1. 

 

1. Before setting the analog outputs of the inverter or I/O expansion card, set the function 

codes P06.14 and P26.35. After values are written to C_SetAO1 (D7627) and C_SetAO2 

(D7628), corresponding analog values can be output on the inverter or I/O expansion card. 

2. The program for configuring PLC card analog input terminal AI1 is as follows: 
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Figure 4.9 Input configuration for AI1 on the PLC card 

The program indicates that AI1 input is enabled, current input is selected (J2 connected to AI), 

and the sampling count is 5. The input current (corresponding to 0–10000) of AI1 can be read 

from SD172 or D7633(C_Ai1Val).  

3. The program for configuring PLC card analog output terminal AO1 is as follows: 

 

Figure 4.10 Output configuration for AO1 on the PLC card 

The program indicates that AO1 output is enabled, and voltage output is selected (J5 

connected to AVO). The output value of AO1 can be provided by writing a value to SD178 and 

can be obtained through D7634(C_Ao1Val). 

4.4 Interfaces for control commands and function commands 

In addition to the digital/analog input/output terminals for Auto Station programming, 

communication commands can be used to control the inverter. Compared with terminal 

functions, communication commands are less and mainly used to control the startup and stop 

of the inverter. The following describes the control commands that Auto Station provides for 

the inverter. 

1. Basic control commands 

Auto Station control commands equal communication-based control commands. Therefore, 

P00.01 must be set to 2 (communication command) for the inverter, and P00.02 must be set to 

4 (PLC card) for the inverter. 
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Table 4.3 Basic control command interface 

Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

C_CTRL D7600 / 

0–10. It is readable and writable. 

The options are as follows: 

0: Disable 

1: Run forward (FWD) 

2: Run reversely (REV) 

3: Jog forward 

4: Jog reversely 

5: Decelerate to stop 

6: Coast to stop 

7: Reset the fault 

8: Quick and emergency stop 

9: Reserved 

10: Reserved 

 

Before using a control command, you need to note: If a running command is given during 

power-on (without completing initialization) or re-running, the inverter enters the running 

protection state. In this case, the inverter will not run until the running command is revoked 

and a new running command is given. (To disable running protection, stop the inverter.) 

To prevent the inverter from entering the running protection state during power-on, it is 

recommended that the running command be given with a delay of 500ms–1000ms after 

power-on. 

Re-running indicates: When the inverter is running, the RUN/STOP switch on the PLC card is 

switched from STOP to RUN or the RUN/STOP button on the Auto Station monitoring 

interface is switched from STOP to RUN. If the running command is not revoked, the inverter 

also enters the running protection state. 

During normal running, the RUN/STOP switch on the PLC card will not be turned to STOP or 

the STOP button on the Auto Station monitoring interface will not be clicked. However, during 

code debugging, the resumable operation may be performed, and you must pay attention to 

whether running protection is enabled.  
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2. Multi-step speed command 

Table 4.4 Multi-step speed command interface 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

C_MFrq D7601 / 

0–16. It is readable and writable. 

The options are as follows: 

0: Disable 

1: Multi-step speed 0 

2: Multi-step speed 1 

3: Multi-step speed 2 

4: Multi-step speed 3 

5: Multi-step speed 4 

6: Multi-step speed 5 

7: Multi-step speed 6 

8: Multi-step speed 7 

9: Multi-step speed 8 

10: Multi-step speed 9 

11: Multi-step speed 10 

12: Multi-step speed 11 

13: Multi-step speed 12 

14: Multi-step speed 13 

15: Multi-step speed 14 

16: Multi-step speed 15 

The multi-step speed setting cannot be greater than 16. The value 0 cannot be used, while the 

default value is 1. This command is only used for channel selection. Each multi-step speed 

must be set through P10 and require the setting of P00.06/P00.07. 

3. ACC/DEC time setting command 

Table 4.5 ACC/DEC time setting command interface 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

C_SpT D7602 / 

0–4. It is readable and writable. 

The options are as follows: 

0: ACC/DEC time 1 

1: ACC/DEC time 2 

2: ACC/DEC time 3 

3: ACC/DEC time 4 
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The value cannot be greater than 3. The default value is 0. This command is only used for 

channel selection. ACC/DEC time must be set through the respective function codes. 

4.5 Interfaces for setting function parameters 

The inverter provides the PLC card with certain function parameter interfaces. You can set 

these parameters on the Auto Station. 

Table 4.6 Interfaces for setting inverter function parameters 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

C_FRQ_SET D7603 / 

0–63000 (corresponding to 0–630.00Hz). It is 

readable and writable. 

To enable the PLC card to set the inverter 

frequency, set P00.06/P00.07=14. 

C_TOR_SET D7604 / 

-3000–3000 (corresponding to 

-300.0%–300.0%). It is readable and writable. 

To enable the PLC card to set the inverter 

torque, set P03.11=12 and P03.32=1. 

C_F_UP_FWD D7605 / 

0–63000 (corresponding to 0–630.00Hz). It is 

readable and writable. 

To enable the PLC card to set forward torque 

upper limit, set P03.32=1, P00.00 to a value 

rather than 2, and P03.14=11. 

C_F_UP_REV D7606 / 

0–63000 (corresponding to 0–630.00Hz). It is 

readable and writable. 

To enable the PLC card to set reverse frequency 

upper limit, set P03.32=1, P00.00 to a value 

rather than 2, and P03.15=11. 

C_T_UP_ELEC D7607 / 

0–3000 (corresponding to 0–300.0%). It is 

readable and writable. 

To enable the PLC card to set electromotion 

torque upper limit, set P03.32=1, P00.00 to a 

value rather than 2, and P03.18=10. 

C_T_UP_GEN D7608 / 

0–3000 (corresponding to 0–300.0%). It is 

readable and writable. 

To enable the PLC card to set braking torque 

upper limit, set P03.32=1, P00.00 to a value 

rather than 2, and P03.19=10. 

C_ACC1 D7609 / 
0–36000 (corresponding to 0–3600.0s). It is 

readable and writable. 
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Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

When inverter ACC time 1 is set to a value rather 

than 0 through the PLC card, ACC time 1 

specified by the value is forcibly used (P00.11 is 

invalid). When inverter ACC time 1 is set to 0 

through the PLC card, ACC time 1 (P00.11) set 

through the inverter keypad is used. 

C_DEC1 D7610 / 

0–36000 (corresponding to 0–3600.0s). It is 

readable and writable. 

When inverter DEC time 1 is set to a value rather 

than 0 through the PLC card, DEC time 1 

specified by the value is forcibly used (P00.12 is 

invalid). When inverter DEC time 1 is set to 0 

through the PLC card, DEC time 1 (P00.12) set 

through the inverter keypad is used. 

C_PID_GV_S D7612 / 

-1000–1000 (corresponding to -100.0–100.0%). 

It is readable and writable. 

To enable the PLC card to set the inverter PID 

reference value, set P00.00 to a value rather 

than 2, P00.06=7 and P09.00=11. 

C_PID_FB_S D7613 / 

-1000–1000 (corresponding to -100.0–100.0%). 

It is readable and writable. 

To enable the PLC card to set the inverter PID 

feedback value, set P00.00 to a value rather than 

2, P00.06=7 and P09.02=9. 

C_VF_SET D7624 / 

0–1000 (corresponding to 0–100.0%). It is 

readable and writable. 

To enable the PLC card to set the inverter VF 

voltage, set P04.00=5 (user-defined V/F) and 

P04.27=12. 

C_UP_FRQ D7625 / Frequency upper limit. Reserved. 

C_DiState D7631 P27.22 

0x00–0x3F. It is read only. 

PLC card digital input terminal status. Bit5–Bit0 

represent PS6–PS1 respectively. 

C_DoState D7632 P27.23 

0x0–0x3. It is read only. 

PLC card digital output terminal status. Bit0 

represents PRO1, and Bit1 represents PRO2. 

4.6 Interfaces for viewing function parameters and inverter status 

1. Viewing function parameters 
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The inverter opens function groups P17 and P18 and certain variables in groups P19 and P27 

for the PLC card. You can use Auto Station interfaces to check inverter function parameters 

(the interfaces vary depending on the actual product development).  

The following table lists the interfaces for viewing HD2 function parameters. For details about 

the function parameters, see HD2 operation manual. 

Table 4.7 Interfaces for viewing function parameters (group 1) 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

I_SetFrq D7400 P17.00 Set frequency of the inverter. It is read only. 

I_OutputFrq D7401 P17.01 Output frequency of the inverter. It is read only. 

I_LineSetFrq D7402 P17.02 
Ramp reference frequency of the inverter. It is 

read only. 

I_DoState D7404 P17.13 
Digital output terminal status of the inverter. It is 

read only. 

I_TorqSet D7405 P17.15 
Torque reference value of the inverter. It is read 

only. 

I_CounterVal D7406 P17.18 Count value of the inverter. It is read only. 

I_HDIA_Frq D7410 P17.21 
HDIA input frequency of the inverter. It is read 

only. 

I_HDIB_Frq D7411 P17.22 
HDIB input frequency of the inverter. It is read 

only. 

I_PID_Set D7412 P17.23 PID reference value. It is read only. 

I_PID_Feedback D7413 P17.24 PID feedback value. It is read only. 

I_PID_Output D7414 P17.38 Process PID output. It is read only. 

I_EncoderFrq D7415 P18.00 Actual frequency of the encoder. It is read only. 

I_CardEnable D7416 P27.00 
Indicates whether to enable the PLC card, which 

is reserved. It is read only. 

Table 4.8 Interfaces for viewing function parameters (group 2) 

Auto Station 

interface 

variable name 

D 

element 

Inverter 

function 

code 

Interface description 

I_OutputVolt D7500 P17.03 Output voltage. It is read only. 

I_OutputCurrent D7501 P17.04 Output current. It is read only. 

I_MotorRpm D7502 P17.05 Motor speed. It is read only. 

I_TorqCurrent D7503 P17.06 Torque current. It is read only. 

I_MagCurrent D7504 P17.07 Exciting current. It is read only. 

I_MotorPower D7505 P17.08 Motor power. It is read only. 
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Auto Station 

interface 

variable name 

D 

element 

Inverter 

function 

code 

Interface description 

I_OutputTorq D7506 P17.36 Output torque. It is read only. 

I_EstMotorFrq D7507 P17.10 Estimated motor frequency. It is read only. 

I_DC_Volt D7508 P17.11 DC bus voltage. It is read only. 

I_LineSpeed D7509 P17.16 Linear speed. It is read only. 

I_PowerFactor D7510 P17.25 Motor power factor. It is read only. 

I_CurRuntime D7511 P17.26 Current running time. It is read only. 

I_CurStage D7512 P17.27 
Simple PLC and current step number of multi-step 

speed. It is read only. 

I_SynMagAngle D7513 P17.29 
Pole angle of open-loop synchronous motor. It is 

read only. 

I_MagCurSet D7514 P17.33 Exciting current reference. It is read only. 

I_TorqCurSet D7515 P17.34 Torque current reference. It is read only. 

I_LineAC_Cur D7516 P17.35 AC incoming current. It is read only. 

I_MotorOutTorq D7517 P17.09 Motor output torque. It is read only. 

I_CtrlMode D7545 P17.40 Motor control mode. It is read only. 

I_TorqUpElec D7546 P17.41 Electromotion torque upper limit. It is read only. 

I_TorqUpGen D7547 P17.42 Braking torque upper limit. It is read only. 

I_TorqFrqUpFw

d 
D7548 P17.43 

Frequency upper limit of forward running in torque 

control. It is read only. 

I_TroqFrqUpRev D7549 P17.44 
Frequency upper limit of reverse running in torque 

control. It is read only. 

2. Viewing temperatures and faults 

The inverter allows the PLC card to read temperature display, power class, and fault display. 

You can use the Auto Station interfaces to view the information (the interfaces vary depending 

on the actual product development). 

The following table lists the interfaces for viewing HD2 temperatures and faults. For details 

about the function parameters, see HD2 operation manual. 

Table 4.9 Interfaces for viewing temperatures and faults 

Auto Station 

interface 

variable name 

D 

element 

Inverter 

function 

code 

Interface description 

I_T_Sink D7518 P07.11 Rectifier bridge module temperature. It is read only. 

I_T_Invert D7519 P07.12 Inverting module temperature. It is read only. 

I_InvertRuntime D7520 P07.14 Accumulative running time. It is read only. 

I_ElectricHigh D7521 P07.15 MSB of inverter electricity consumption. It is read 
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Auto Station 

interface 

variable name 

D 

element 

Inverter 

function 

code 

Interface description 

only. 

I_ElectricLow D7522 P07.16 
LSB of inverter electricity consumption. It is read 

only. 

I_FaultType D7523 P07.27 Type of present fault. It is read only. 

I_FaultRunFrq D7524 P07.33 
Running frequency at most recent fault. It is read 

only. 

I_FaultLineFrq D7525 P07.34 
Ramp reference frequency at most recent fault. It is 

read only. 

I_FaultOutVolt D7526 P07.35 Output voltage at most recent fault. It is read only. 

I_FaultOutCur D7527 P07.36 Output current at most recent fault. It is read only. 

I_FaultDcVolt D7528 P07.37 Bus voltage at most recent fault. It is read only. 

I_FaultTemper D7529 P07.38 
Max. temperature at most recent fault. It is read 

only. 

I_FaultDi D7530 P07.39 
Input terminal status at most recent fault. It is read 

only. 

I_FaultDo D7531 P07.40 
Output terminal status at most recent fault. It is read 

only. 

 

3. Viewing inverter current status and parameters 

The inverter allows the Auto Station to invoke the inverter status and some other parameters, 

some of which are the same as corresponding parameters in group P17. 

Table 4.10 Interface for viewing inverter current status and parameters 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

I_InvtState1 D7532 / 

inverter status 1. It is read only. 

1: In forward running 

2: In reverse running 

3: Stopped 

4: Faulty 

5: PoFF 

I_InvtState2 D7533 / 

inverter status 2. It is read only. 

Bit0: =0: Not ready to run =1: Ready to run 

Bit1–Bit2: =00: Motor 1=01: Motor 2 =10: Motor 

3  =11: Motor 4 

Bit3: =0: Asynchronous motor =1: Synchronous 
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Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

motor 

Bit4: =0: No overload alarm =1: Overload alarm 

Bit5–Bit6: =00: Keypad-based control =01: 

Terminal-based control =10: 

Communication-based control 

Bit7: Reserved 

Bit8: =0: Speed mode =1: Torque mode 

Bit9: =0: Non position mode =1: Position mode 

Bit10–Bit11: =00: Without-PG vector control 

mode 0 =01: Without-PG vector control mode 1 

=10: Closed-loop vector control mode =11: V/F 

control mode 

Bit12–Bit15: Reserved 

I_InvtErrCode D7534 / inverter fault code. It is read only. 

4.7 PLC card user-defined fault interface 

The PLC card provides 10 usr-defined faults that can be used for the secondary development 

on the Auto Station. These PLC-defined faults will be sent back to the inverter and shown as 

external faults on the inverter panel. The symbol for these faults is C_P_Err (DSP fault code 

display also synchronized). See the following table for the faults. 

Table 4.11 PLC card user-defined fault interface 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

C_P_Err D7611 / 

PLC card user-defined fault. It is readable and 

writable. 

0: No fault (fault cleared) 

1: PLC card user-defined fault 1 

2: PLC card user-defined fault 2 

3: PLC card user-defined fault 3 

4: PLC card user-defined fault 4 

5: PLC card user-defined fault 5 

6: PLC card user-defined fault 6 

7: PLC card user-defined fault 7 

8: PLC card user-defined fault 8 

9: PLC card user-defined fault 9 

10: PLC card user-defined fault 10 
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Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

The C_P_Err fault code ranges from 1 to 10. A 

fault code greater than 10 is invalid. 

The inverter stops once a PLC card user-defined fault occurs. To resume the running, reset 

the fault (the method for handling a PLC card user-defined fault is similar to that for handling a 

inverter fault.) Pay attention to the following during programming: If the fault condition 

disappears, remove the fault immediately; otherwise, reset cannot be performed. The inverter 

only displays one fault, which means that the inverter does not report another fault when the 

inverter has reported one fault. 

4.8 Interfaces for writing data 

The inverter provides a group of parameters configurable so that you can enable the inverter 

to write data to the PLC card. 

You can write data to the parameters on the PLC card by setting inverter P27 function codes 

(that is, you can invoke P27 function code interfaces through the Auto Station to assign values 

to variables.) You can define 10 interfaces for writing data to the PLC card. 

Table 4.12 Interfaces for writing data to the PLC card 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

I_WrP1 D7535 P27.01 
Value that the inverter writes to WrP1 on the PLC 

card. It is read only. 

I_WrP2 D7536 P27.02 
Value that the inverter writes to WrP2 on the PLC 

card. It is read only. 

I_WrP3 D7537 P27.03 
Value that the inverter writes to WrP3 on the PLC 

card. It is read only. 

I_WrP4 D7538 P27.04 
Value that the inverter writes to WrP4 on the PLC 

card. It is read only. 

I_WrP5 D7539 P27.05 
Value that the inverter writes to WrP5 on the PLC 

card. It is read only. 

I_WrP6 D7540 P27.06 
Value that the inverter writes to WrP6 on the PLC 

card. It is read only. 

I_WrP7 D7541 P27.07 
Value that the inverter writes to WrP7 on the PLC 

card. It is read only. 

I_WrP8 D7542 P27.08 
Value that the inverter writes to WrP8 on the PLC 

card. It is read only. 

I_WrP9 D7543 P27.09 Value that the inverter writes to WrP9 on the PLC 
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Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

card. It is read only. 

I_WrP10 D7544 P27.10 
Value that the inverter writes to WrP10 on the 

PLC card. It is read only. 

 

4.9 Interfaces for monitoring PLC card data 

The inverter provides a group of function codes for the PLC card to monitor PLC card data. 

You can perform secondary development on the Auto Station to send to-be-monitored PLC 

card data to Auto Station programming interfaces corresponding to P27. The inverter can 

monitor the data through P27. A total of 10 Auto Station interfaces can be defined.  

Table 4.13 Interfaces for monitoring PLC card data 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

C_MoP1 D7614 P27.12 
MoP1 value monitored by the inverter. It is 

readable and writable. 

C_MoP2 D7615 P27.13 
MoP2 value monitored by the inverter. It is 

readable and writable. 

C_MoP3 D7616 P27.14 
MoP3 value monitored by the inverter. It is 

readable and writable. 

C_MoP4 D7617 P27.15 
MoP4 value monitored by the inverter. It is 

readable and writable. 

C_MoP5 D7618 P27.16 
MoP5 value monitored by the inverter. It is 

readable and writable. 

C_MoP6 D7619 P27.17 
MoP6 value monitored by the inverter. It is 

readable and writable. 

C_MoP7 D7620 P27.18 
MoP7 value monitored by the inverter. It is 

readable and writable. 

C_MoP8 D7621 P27.19 
MoP8 value monitored by the inverter. It is 

readable and writable. 

C_MoP9 D7622 P27.20 
MoP9 value monitored by the inverter. It is 

readable and writable. 

C_MoP10 D7623 P27.21 
MoP10 value monitored by the inverter. It is 

readable and writable. 
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4.10 RUN/STOP switch and PLC card running status 

The RUN/STOP switch on the PLC card is used to start or stop the PLC program and does not 

affect PLC program download. If the switch is turned to STOP, the PLC program is stopped. If 

the switch is turned to RUN, the PLC program runs. The status can be viewed through P27.11. 

If the switch is turned from RUN to STOP, the control command given to the inverter is cleared 

(if the inverter is running, the inverter stops at this situation), hardware output (including 

inverter AO1/AO2/RO1/RO2/Y1/Y2 and PLC card PRO1/PRO2/AO1/External fault) is cleared. 

If the switch is turned from STOP to RUN, output is executed with a delay of 0.5s. 

Table 4.14 Description of SW1 on the PLC card 

SW1 Function Description 

RUN To run PLC programs 

PLC programs are executed. If the switch is 

turned from STOP to RUN, output is executed 

with a delay of 0.5s. 

STOP To stop PLC programs Stopping PLC programs will clear PLC output. 

Output of the PLC card indicates the control command that the PLC card sends to the inverter. 

Hardware output includes inverter AO1/AO2/RO1/RO2/Y1/Y2 and PLC card 

PRO1/PRO2/AO1/External fault. 

1. If the RUN/STOP switch is turned to STOP: if the Auto Station is being used for monitoring 

now, the RUN button on the Auto Station is invalid and turned to the STOP state; if the 

RUN/STOP button on the Auto Station is turned to STOP during the online monitoring 

debugging, PLC programs are suspended, PLC output is cleared, and the inverter coasts to 

stop. 

2. If the RUN/STOP switch is turned to RUN: if the Auto Station is being used for monitoring 

now, the RUN/STOP button on the Auto Station is valid and turned to the RUN state; PLC 

programs resume running, but the hardware PLC output activates with a delay of 0.5s, and the 

running command that is given to the inverter again (the inverter not in running protection state) 

also activates with a delay of 0.5s. 

The correct operation procedure is as follows: Before downloading programs from the Auto 

Station to the PLC card, turn the RUN/STOP switch on the PLC card to STOP. After the 

download, turn the RUN/STOP switch on the PLC card to RUN. In addition, you can debug 

code online and perform monitoring and use the RUN/STOP button on the Auto Station to 

perform control the output of the PLC card.  

You can enable the monitoring mode of the Auto Station or check the value of inverter function 

code P27.11 to view the running status of the PLC card. 
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Table 4.15 Interface for viewing the running status of the PLC card 

Auto Station 

interface 

variable name 

D element 

Inverter 

function 

code 

Interface description 

C_RunStopState D7630 P27.11 

It displays the current running status of the PLC 

card. It is read only. 

0: Stopped 

1: Running 

4.11 DP/CANopen/PN communication channel 

The inverter uses function code P27.26 to control the data volume (send by 2 groups) 

exchanged between the PLC card and inverter to reduce communication time. By default, 

P27.26 is 0x03, indicating only the data exchanged through the interfaces mentioned earlier is 

involved. If you want to enable the DP/CANopen/PN communication channel for the PLC card, 

change the value of P27.26 accordingly. 

Table 4.16 Description of function code P27.26 

Function 

code 
Function name Description Default Modify 

P27.26 

Length of data 

sent from the 

PLC card and 

PZD 

communication 

object 

0x00–0x28 

Ones place: Quantity of data sent 

from the programmable card and 

inverter (that is, quantity of data sent 

from the programmable card + from 

inverter sending table 1 + from 

inverter sending table 2) 

0: 0+24+60 

1: 12+24+60 

2: 24+24+60 

3: 36+24+60 

4: 48+24+60 

5: 60+48+60 

6: 72+24+60 

7: 84+24+60 

8: 96+96+96 

Tens place: Card that communicates 

with the programmable card through 

PZD (valid only when the ones place 

of P27.26 is 5) 

0x03 ○ 
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Function 

code 
Function name Description Default Modify 

0: DP card 

1: CANopen card 

2: PN card 

Note: P27.26 can be changed at any 

time, but the change takes effect only 

after re-power on. 

The following describes the communication channel between the PLC card and 

DP/CANopen/PN card. The PLC card defines two groups of PZD channel, used for writing and 

read, and each group has 24 PZD channels. The writing channels are used to send data from 

the DP/CANopen/PN card to the PLC card for secondary programming and then send the 

processed data to the inverter. The reading channels are used to send data from the inverter 

to the PLC card for secondary programming and then send the processed data to the 

DP/CANopen/PN card. The following figure shows how the data is transferred. 

 

Figure 4.11 Data transfer between the PLC card and DP/CANopen/PN card 

As shown in the figure, the host computer sends data by using the writing channels.  

① The host computer sends data to the DP/CANopen/PN card. 

② After parsing the data from the host computer, the DP/CANopen/PN card encapsulates the 

data into frames and sends the frames to PZD1–12 on the DSP. This group of PZD are 

transferred to the corresponding elements D7424–D7435 (corresponding to Auto Station 

interface variables I_WrSend_PZD1–I_WrSend_PZD12) on the PLC card. 

③ You can use the Auto Station to perform secondary programming on D7424–D7435 

(corresponding Auto Station interface variables I_WrSend_PZD1–I_WrSend_PZD12) on the 

PLC card. After the processing, the data is sent to D7636–D7647 (corresponding to Auto 
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Station interface variables C_WrRece_PZD1–C_WrRece_PZD12). Then the PLC card sends 

this group of D elements to the DP/CANopen/PN card parsing program on the DSP for 

parsing. 

As shown in the figure, the host computer receives data by using the reading channels. 

① The DSP sends data to the PLC card by using D7436–D7447 (corresponding to Auto 

Station interface variables I_RdSend_PZD1–I_RdSend_PZD12). 

② You can use the Auto Station to perform secondary programming on D7436–D7447 

(corresponding to Auto Station interface variables I_RdSend_PZD1–I_RdSend_PZD12). After 

the processing, the data is sent to D7648–D7659 (corresponding to Auto Station interface 

variables C_RdRece_PZD1–C_RdRece_PZD12). Then the PLC card sends this group of D 

elements to the DSP channels for communication with the DP/CANopen/PN card. 

③ After receiving the data, the DP/CANopen/PN card sends the data to the host computer. 

The following table describes the channel interfaces. 

Table 4.17 PZD writing channel interfaces 

Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

I_WrSend_PZD1 D7424 / 
Control word (CW), which is the first PZD sent 

from the DP/CANopen/PN card 

I_WrSend_PZD2 D7425 / PZD2 sent from the DP/CANopen/PN card 

I_WrSend_PZD3 D7426 / PZD3 sent from the DP/CANopen/PN card 

I_WrSend_PZD4 D7427 / PZD4 sent from the DP/CANopen/PN card 

I_WrSend_PZD5 D7428 / PZD5 sent from the DP/CANopen/PN card 

I_WrSend_PZD6 D7429 / PZD6 sent from the DP/CANopen/PN card 

I_WrSend_PZD7 D7430 / PZD7 sent from the DP/CANopen/PN card 

I_WrSend_PZD8 D7431 / PZD8 sent from the DP/CANopen/PN card 

I_WrSend_PZD9 D7432 / PZD9 sent from the DP/CANopen/PN card 

I_WrSend_PZD10 D7433 / PZD10 sent from the DP/CANopen/PN card 

I_WrSend_PZD11 D7434 / PZD11 sent from the DP/CANopen/PN card 

I_WrSend_PZD12 D7435 / PZD12 sent from the DP/CANopen/PN card 

C_WrRece_PZD1 D7636 / CW sent to the inverter 

C_WrRece_PZD2 D7637 / PZD2 sent to the inverter 

C_WrRece_PZD3 D7638 / PZD3 sent to the inverter 

C_WrRece_PZD4 D7639 / PZD4 sent to the inverter 

C_WrRece_PZD5 D7640 / PZD5 sent to the inverter 
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Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

C_WrRece_PZD6 D7641 / PZD6 sent to the inverter 

C_WrRece_PZD7 D7642 / PZD7 sent to the inverter 

C_WrRece_PZD8 D7643 / PZD8 sent to the inverter 

C_WrRece_PZD9 D7644 / PZD9 sent to the inverter 

C_WrRece_PZD10 D7645 / PZD10 sent to the inverter 

C_WrRece_PZD11 D7646 / PZD11 sent to the inverter 

C_WrRece_PZD12 D7647 / PZD12 sent to the inverter 

Note: The preceding parameters require the setting of function groups P15 and P16. For 

example, if you want to set the frequency for the inverter through the DP card, set 

P27.26=0x05 and P15.02=1, and set PZD2 to the required value (and pay attention to the 

decimal place and unit conversion) on the host computer. Then the set frequency is 

transferred to I_WrSend_PZD2 (D7425). If I_WrSend_PZD2 (D7425) is directly sent to 

C_WrRece_PZD2 (D7637), the set frequency is enabled on the inverter. If I_WrSend_PZD2 

(D7425) is sent to C_WrRece_PZD2 (D7637) after being processed, the processed set 

frequency is enabled on the inverter. 

Table 4.18 PZD reading channel interfaces 

Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

I_RdSend_PZD1 D7436 / 
Status word (SW), which is the first PZD sent 

from the inverter 

I_RdSend_PZD2 D7437 / PZD2 sent from the inverter 

I_RdSend_PZD3 D7438 / PZD3 sent from the inverter 

I_RdSend_PZD4 D7439 / PZD4 sent from the inverter 

I_RdSend_PZD5 D7440 / PZD5 sent from the inverter 

I_RdSend_PZD6 D7441 / PZD6 sent from the inverter 

I_RdSend_PZD7 D7442 / PZD7 sent from the inverter 

I_RdSend_PZD8 D7443 / PZD8 sent from the inverter 

I_RdSend_PZD9 D7444 / PZD9 sent from the inverter 

I_RdSend_PZD10 D7445 / PZD10 sent from the inverter 

I_RdSend_PZD11 D7446 / PZD11 sent from the inverter 

I_RdSend_PZD12 D7447 / PZD12 sent from the inverter 

C_RdRece_PZD1 D7648 / SW sent to the DP/CANopen/PN card 

C_RdRece_PZD2 D7649 / PZD2 sent to the DP/CANopen/PN card 
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Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

C_RdRece_PZD3 D7650 / PZD3 sent to the DP/CANopen/PN card 

C_RdRece_PZD4 D7651 / PZD4 sent to the DP/CANopen/PN card 

C_RdRece_PZD5 D7652 / PZD5 sent to the DP/CANopen/PN card 

C_RdRece_PZD6 D7653 / PZD6 sent to the DP/CANopen/PN card 

C_RdRece_PZD7 D7654 / PZD7 sent to the DP/CANopen/PN card 

C_RdRece_PZD8 D7655 / PZD8 sent to the DP/CANopen/PN card 

C_RdRece_PZD9 D7656 / PZD9 sent to the DP/CANopen/PN card 

C_RdRece_PZD10 D7657 / PZD10 sent to the DP/CANopen/PN card 

C_RdRece_PZD11 D7658 / PZD11 sent to the DP/CANopen/PN card 

C_RdRece_PZD12 D7659 / PZD12 sent to the DP/CANopen/PN card 

Note: The preceding parameters require the setting of function groups P15 and P16. For 

example, if you want to enable the DP card to read the set frequency of the inverter, set 

P27.26=0x05 and P15.13=2. Then the inverter transfers the set frequency to I_RdSend_PZD2 

(D7437). If I_RdSend_PZD2 (D7437) is directly sent to C_RdRece_PZD2 (D7649), the set 

frequency of the inverter is read from PZD2 of the host computer. If I_RdSend_PZD2 (D7437) 

is sent to C_RdRece_PZD2 (D7649) after being processed, the processed set frequency of 

the inverter is read from PZD2 of the host computer. 

4.12 RS485 communication and power-outage saving 

1. RS485 communication 

The PLC card designs a channel of RS485 communication, for which you can set the 

parameters such as master/slave mode, port number, and baud rate through the Auto Station. 

In addition, the Auto Station allows Modbus-RTU communication. For details about 

Modbus-RTU, see HD2 Series High-performance Multifunction inverter or visit the Internet for 

related reference. 

2. Power-outage saving 

The PLC card provides a power-outage saving zone (flash memory) about 1K words. When 

encountering a power outage, the inverter sends a power outage signal to the PLC card. After 

receiving the signal, the PLC card saves data about the elements in the power-outage saving 

range already specified on the Auto Station (note that the power-outage saving range can take 

effect only after being downloaded to the PLC card). After re-power on, the data about the 
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elements in the power-outage saving range is automatically read and restored to the 

corresponding elements. The power-outage saving function is applicable to the M, S, D, and C 

elements.  

Note: The power-outage saving function is not applicable to D7400–D7699, which are 

variables exchanged with the inverter. To protect the values of D7400–D7695 at a power 

outage, assign the values of this segment to other 7700 D elements in advance, and enable 

power-outage saving for the D elements assigned with these values. After re-power on, you 

can assign these values that are saved at power outage to D7400–D7699. 

The method for configuring the power-outage saving function is as follows: 

Double-click Saving Range under System block in the Project Manager. By default, the 

Auto Station already has a saving range, which can be cleared for new setting. Note: The 

saving range can take effect only after being downloaded to the PLC card. 

 

Figure 4.12 Setting a saving range 

As shown in the preceding figure, the saving range is the 1000 D elements D100–D1099. 
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5 Programming cases 

5.1 For PLC card digital input/output terminals 

Requirement: When the PS1 terminal of the PLC card has an input signal, the RO1 terminal of 

the inverter has output. When both the S2 and S3 terminals of the inverter have an input signal, 

the RO2 terminal of the inverter has output. 

Implementing method: The LD is used for programming. 

Inverter function code setting: P06.03=44 (RO1 is given by the PLC card) and P06.04=45 

(RO2 is given by the PLC card) 

The following figure shows the code example and online debugging result: 

 

Figure 5.1 Programming case for PLC card digital input/output terminals 

5.2 For terminal-based running/fault control 

Requirement: When the PS5 terminal on the PLC card has an input signal, the inverter runs 

forward. When the PS6 terminal on the PLC card has an input signal, the inverter runs 

reversely. When a fault occurs, the fault can be reset through input to the S3 terminal on the 

inverter. When the S4 terminal on the inverter has input, external PLC fault 5 occurs. 

Implementing method: The LD is used for programming. The programming logic is as follows: 

Run forward=PS5, Run reversely=(!PS5)&PS6, Decelerate to stop=(!PS5)&(!PS6), External 

fault 5=S4, Fault reset=(!S4)&S3 

Inverter function code setting: P00.01=2, P00.02=4, P00.06=a value ensuring the set 

frequency is not 0 



HD2-E-PLC Auto Station Software  Programming cases 

-38- 

The following figure shows the code example and partial testing result (about fault occurring): 

 

Figure 5.2 Programming case for terminal-based running/fault control 

5.3 For multi-step setting and running 

Requirement: An unsigned 16-bit variable APPLE is defined, which increases by 1 circularly 

(rang: 0–65535).  

When APPLE < 10000, multi-step speed 0 is used.  

When 10000 ≤ APPLE < 20000, multi-step speed 1 is used.  

When 20000 ≤ APPLE < 30000, multi-step speed 2 is used.  

When 30000 ≤ APPLE < 40000, multi-step speed 3 is used.  

When 40000 ≤ APPLE < 50000, multi-step speed 4 is used.  

When 50000 ≤ APPLE, multi-step speed 5 is used.  

The variable APPLE is saved to P27.12 so that the inverter can monitor the value change. 

When the S1 terminal on the inverter has input, the inverter runs. When the PS1 terminal on 

the PLC card has input, the PRO1 and PRO2 terminals on the PLC card have output. 

Implementing method: The LD is used for programming. Add a line to the global variable table 

and set the element (for example, D1000) corresponding to APPLE. Note that an element 

among D7400–D7699 cannot be used. 
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Figure 5.3 Defining a global variable APPLE 

Inverter function code setting: P00.01=2, P00.02=4, P00.06=6, multi-step speed settings in 

P10 

The following figure shows the code example and partial testing result: 

 

Figure 5.4 Programming case for multi-step setting and running 

As shown in the preceding figure, APPLE may be negative. This is because the system 

considers the single D element (APPLE) as an integer during the increase and therefore uses 

signed display. The D elements on the Auto Station can be divided into the integer type and 
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the long integer type, but not the unsigned integer type. The preceding judging zone uses the 

hex restriction method. No change can be made for the transfer to P27.12 since the data 

showed in P27.12 is an unsigned number. 

5.4 For RS485 communication 

Requirement: The bus voltage of 2# inverter can be obtained, the input from AI1 on the PLC 

card is used to set the frequency for 2# inverter, and PS1 on the PLC card is pressed to run 2# 

inverter forward. For 3# inverter on the RS485 cable, the output frequency can be read, and 

the set frequency can be changed and can increase automatically by 1Hz. 

 

Figure 5.5 PLC card networking example 

Implementing method: The LD is used for programming. On the left of the Auto Station, 

expand System block, double-click Serial port, select the parameter settings for PLC 

communication port (1), choose the Modbus protocol, and right-click Modbus setting. The 

default setting is Slave Station. Change the setting to Master Station, set the site number to 

1, and retain other default settings. (Note: For Modbus communication, all other parameters 

must use default settings except the site number. This is to keep the same protocol for the two 

sides.) Regarding the hardware, short connect AV on the PLC card to J2, and short connect 

AVO on the PLC card to J5 (this is the default short-connection). Connect the 485+ terminal 

on the PLC card to the 485+ terminals on 2# inverter and 3# inverter and connect the 485- 

terminal on the PLC card to the 485- terminals on 2# inverter and 3# inverter. 

Inverter function code setting: Set P14.00=2, P00.01=2, and P00.02=4 for 2# inverter. Set 

P14.00=3 for 3# inverter. 
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Figure 5.6 Programming case for RS485 communication 
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Appendix 1 D elements for exchange between the PLC card 
and inverter 

Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

I_SetFrq D7400 P17.00 Set frequency of the inverter. It is read only. 

I_OutputFrq D7401 P17.01 
Output frequency of the inverter. It is read 

only. 

I_LineSetFrq D7402 P17.02 
Ramp reference frequency of the inverter. It 

is read only. 

I_DiState D7403 P17.12 

I_DiState is an unsigned 16-bit number, 

which is read only. 

Each bit represents a unique digital input 

terminal on the inverter: 

Bit0: S1 

Bit1: S2 

Bit2: S3 

Bit3: S4 

Bit4: S5 (Inverter I/O expansion card input 

terminal S5) 

Bit5: S6 (Inverter I/O expansion card input 

terminal S6) 

Bit6: S7 (Inverter I/O expansion card input 

terminal S7) 

Bit7: S8 (Inverter I/O expansion card input 

terminal S8) 

Bit8: HDIA (for digital input) 

Bit9: HDIB (for digital input) 

Bit10–Bit15: Reserved 

I_DoState D7404 P17.13 
Digital output terminal status of the inverter. 

It is read only. 

I_TorqSet D7405 P17.15 
Torque reference value of the inverter. It is 

read only. 

I_CounterVal D7406 P17.18 Count value of the inverter. It is read only. 

I_AI1 D7407 P17.19 

0.00–10.00V/0.00–20.00mA. It is read only. 

inverter analog input terminal AI1, 

corresponding to 0–1000/0–1000 

I_AI2 D7408 P17.20 
-10.00–10.00V. It is read only. 

inverter analog input terminal AI2, 
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Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

corresponding to -1000–1000 

I_AI3 D7409 P19.09 

0.00–10.00V/0.00–20.00mA. It is read only. 

inverter I/O expansion card analog input 

terminal AI3, corresponding to 

0–1000/0–1000 

I_HDIA_Frq D7410 P17.21 
HDIA input frequency of the inverter. It is 

read only. 

I_HDIB_Frq D7411 P17.22 
HDIB input frequency of the inverter. It is 

read only. 

I_PID_Set D7412 P17.23 PID reference value. It is read only. 

I_PID_Feedback D7413 P17.24 PID feedback value. It is read only. 

I_PID_Output D7414 P17.38 Process PID output. It is read only. 

I_EncoderFrq D7415 P18.00 
Actual frequency of the encoder. It is read 

only. 

I_CardEnable D7416 P27.00 
Indicates whether to enable the PLC card 

function, which is reserved. It is read only. 

I1_Reserve1–7 
D7417–D74

23 
/ Reserved. 

I_WrSend_PZD1 D7424 / 
CW, which is the first PZD sent from the 

DP/CANopen/PN card 

I_WrSend_PZD2 D7425 / PZD2 sent from the DP/CANopen/PN card 

I_WrSend_PZD3 D7426 / PZD3 sent from the DP/CANopen/PN card 

I_WrSend_PZD4 D7427 / PZD4 sent from the DP/CANopen/PN card 

I_WrSend_PZD5 D7428 / PZD5 sent from the DP/CANopen/PN card 

I_WrSend_PZD6 D7429 / PZD6 sent from the DP/CANopen/PN card 

I_WrSend_PZD7 D7430 / PZD7 sent from the DP/CANopen/PN card 

I_WrSend_PZD8 D7431 / PZD8 sent from the DP/CANopen/PN card 

I_WrSend_PZD9 D7432 / PZD9 sent from the DP/CANopen/PN card 

I_WrSend_PZD10 D7433 / PZD10 sent from the DP/CANopen/PN card 

I_WrSend_PZD11 D7434 / PZD11 sent from the DP/CANopen/PN card 

I_WrSend_PZD12 D7435 / PZD12 sent from the DP/CANopen/PN card 

I_RdSend_PZD1 D7436 / 
SW, which is the first PZD sent from the 

inverter 

I_RdSend_PZD2 D7437 / PZD2 sent from the inverter 

I_RdSend_PZD3 D7438 / PZD3 sent from the inverter 

I_RdSend_PZD4 D7439 / PZD4 sent from the inverter 

I_RdSend_PZD5 D7440 / PZD5 sent from the inverter 
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Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

I_RdSend_PZD6 D7441 / PZD6 sent from the inverter 

I_RdSend_PZD7 D7442 / PZD7 sent from the inverter 

I_RdSend_PZD8 D7443 / PZD8 sent from the inverter 

I_RdSend_PZD9 D7444 / PZD9 sent from the inverter 

I_RdSend_PZD10 D7445 / PZD10 sent from the inverter 

I_RdSend_PZD11 D7446 / PZD11 sent from the inverter 

I_RdSend_PZD12 D7447 / PZD12 sent from the inverter 

I1_Reserve8–55 
D7448–D74

95 
/ Reserved 

I_OutputVolt D7500 P17.03 Output voltage. It is read only. 

I_OutputCurrent D7501 P17.04 Output current. It is read only. 

I_MotorRpm D7502 P17.05 Motor speed. It is read only. 

I_TorqCurrent D7503 P17.06 Torque current. It is read only. 

I_MagCurrent D7504 P17.07 Exciting current. It is read only. 

I_MotorPower D7505 P17.08 Motor power. It is read only. 

I_OutputTorq D7506 P17.36 Output torque. It is read only. 

I_EstMotorFrq D7507 P17.10 Estimated motor frequency. It is read only. 

I_DC_Volt D7508 P17.11 DC bus voltage. It is read only. 

I_LineSpeed D7509 P17.16 Linear speed. It is read only. 

I_PowerFactor D7510 P17.25 Motor power factor. It is read only. 

I_CurRuntime D7511 P17.26 Current running time. It is read only. 

I_CurStage D7512 P17.27 
Simple PLC and current step number of 

multi-step speed. It is read only. 

I_SynMagAngle D7513 P17.29 
Pole angle of open-loop synchronous motor. 

It is read only. 

I_MagCurSet D7514 P17.33 Exciting current reference. It is read only. 

I_TorqCurSet D7515 P17.34 Torque current reference. It is read only. 

I_LineAC_Cur D7516 P17.35 AC incoming current. It is read only. 

I_MotorOutTorq D7517 P17.09 Motor output torque. It is read only. 

I_T_Sink D7518 P07.11 
Rectifier bridge module temperature. It is 

read only. 

I_T_Invert D7519 P07.12 Inverting module temperature. It is read only. 

I_InvertRuntime D7520 P07.14 Accumulative running time. It is read only. 

I_ElectricHigh D7521 P07.15 
MSB of inverter electricity consumption. It is 

read only. 

I_ElectricLow D7522 P07.16 
LSB of inverter electricity consumption. It is 

read only. 
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Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

I_FaultType D7523 P07.27 Type of present fault. It is read only. 

I_FaultRunFrq D7524 P07.33 
Running frequency at most recent fault. It is 

read only. 

I_FaultLineFrq D7525 P07.34 
Ramp reference frequency at most recent 

fault. It is read only. 

I_FaultOutVolt D7526 P07.35 
Output voltage at most recent fault. It is read 

only. 

I_FaultOutCur D7527 P07.36 
Output current at most recent fault. It is read 

only. 

I_FaultDcVolt D7528 P07.37 
Bus voltage at most recent fault. It is read 

only. 

I_FaultTemper D7529 P07.38 
Max. temperature at most recent fault. It is 

read only. 

I_FaultDi D7530 P07.39 
Input terminal status at most recent fault. It is 

read only. 

I_FaultDo D7531 P07.40 
Output terminal status at most recent fault. It 

is read only. 

I_InvtState1 D7532 / 

Inverter status 1. It is read only. 

1: In forward running 

2: In reverse running 

3: Stopped 

4: Faulty 

5: PoFF 

I_InvtState2 D7533 / 

Inverter status 2. It is read only. 

Bit0: =0: Not ready to run =1: Ready to run 

Bit1–Bit2: =00: Motor 1=01: Motor 2 =10: 

Motor 3  =11: Motor 4 

Bit3: =0: Asynchronous motor =1: 

Synchronous motor 

Bit4: =0: No overload alarm =1: Overload 

alarm 

Bit5–Bit6: =00: Keypad-based control =01: 

Terminal-based control =10: 

Communication-based control 

Bit7: Reserved 

Bit8: =0: Speed mode =1: Torque mode 

Bit9: =0: Non position mode =1: Position 

mode 
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Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

Bit10–Bit11: =00: Without-PG vector control 

mode 0 =01: Without-PG vector control 

mode 1 =10: Closed-loop vector control 

mode =11: V/F control mode 

Bit12–Bit15: Reserved 

I_InvtErrCode D7534 / Inverter fault code. It is read only. 

I_WrP1 D7535 / 
Value that the inverter writes to WrP1 on the 

PLC card. It is read only. 

I_WrP2 D7536 / 
Value that the inverter writes to WrP2 on the 

PLC card. It is read only. 

I_WrP3 D7537 / 
Value that the inverter writes to WrP3 on the 

PLC card. It is read only. 

I_WrP4 D7538 / 
Value that the inverter writes to WrP4 on the 

PLC card. It is read only. 

I_WrP5 D7539 / 
Value that the inverter writes to WrP5 on the 

PLC card. It is read only. 

I_WrP6 D7540 / 
Value that the inverter writes to WrP6 on the 

PLC card. It is read only. 

I_WrP7 D7541 / 
Value that the inverter writes to WrP7 on the 

PLC card. It is read only. 

I_WrP8 D7542 / 
Value that the inverter writes to WrP8 on the 

PLC card. It is read only. 

I_WrP9 D7543 / 
Value that the inverter writes to WrP9 on the 

PLC card. It is read only. 

I_WrP10 D7544 / 
Value that the inverter writes to WrP10 on 

the PLC card. It is read only. 

I_CtrlMode D7545 P17.40 Motor control mode. It is read only. 

I_TorqUpElec D7546 P17.41 
Electromotion torque upper limit. It is read 

only. 

I_TorqUpGen D7547 P17.42 Braking torque upper limit. It is read only. 

I_TorqFrqUpFwd D7548 P17.43 
Frequency upper limit of forward running in 

torque control. It is read only. 

I_TroqFrqUpRev D7549 P17.44 
Frequency upper limit of reverse running in 

torque control. It is read only. 

I2_Reserve1–10 
D7550–D75

59 
/ Reserved 

I2_Reserve11–46 D7560– / Reserved 



HD2-E-PLC Auto Station Software  Appendix 1 

-48- 

Auto Station 

interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

D7595 

C_CTRL D7600 / 

0–10. It is readable and writable. 

The options are as follows: 

0: Disable 

1: Run forward (FWD) 

2: Run reversely (REV) 

3: Jog forward 

4: Jog reversely 

5: Decelerate to stop 

6: Coast to stop 

7: Reset the fault 

8: Quick and emergency stop 

9: Reserved 

10: Reserved 

C_MFrq D7601 / 

0–16. It is readable and writable. 

The options are as follows: 

0: Disable 

1: Multi-step speed 0 

2: Multi-step speed 1 

3: Multi-step speed 2 

4: Multi-step speed 3 

5: Multi-step speed 4 

6: Multi-step speed 5 

7: Multi-step speed 6 

8: Multi-step speed 7 

9: Multi-step speed 8 

10: Multi-step speed 9 

11: Multi-step speed 10 

12: Multi-step speed 11 

13: Multi-step speed 12 

14: Multi-step speed 13 

15: Multi-step speed 14 

16: Multi-step speed 15 

C_SpT D7602 / 

0–4. It is readable and writable. 

The options are as follows: 

0: ACC/DEC time 1 

1: ACC/DEC time 2 

2: ACC/DEC time 3 
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interface variable 

name 

D element 

Inverter 

function 

code 

Interface description 

3: ACC/DEC time 4 

C_FRQ_SET D7603 / 

0–63000 (corresponding to 0–630.00Hz). It 

is readable and writable. 

To enable the PLC card to set the inverter 

frequency, set P00.06/P00.07=14. 

C_TOR_SET D7604 / 

-3000–3000 (corresponding to 

-300.0%–300.0%). It is readable and 

writable. 

To enable the PLC card to set the inverter 

torque, set P03.11=12 and P03.32=1. 

C_F_UP_FWD D7605 / 

0–63000 (corresponding to 0–630.00Hz). It 

is readable and writable. 

To enable the PLC card to set forward 

torque upper limit, set P03.32=1, P00.00 to 

a value rather than 2, and P03.14=11. 

C_F_UP_REV D7606 / 

0–63000 (corresponding to 0–630.00Hz). It 

is readable and writable. 

To enable the PLC card to set reverse 

frequency upper limit, set P03.32=1, P00.00 

to a value rather than 2, and P03.15=11. 

C_T_UP_ELEC D7607 / 

0–3000 (corresponding to 0–300.0%). It is 

readable and writable. 

To enable the PLC card to set electromotion 

torque upper limit, set P03.32=1, P00.00 to 

a value rather than 2, and P03.18=10. 

C_T_UP_GEN D7608 / 

0–3000 (corresponding to 0–300.0%). It is 

readable and writable. 

To enable the PLC card to set braking 

torque upper limit, set P03.32=1, P00.00 to 

a value rather than 2, and P03.19=10. 

C_ACC1 D7609 / 

0–36000 (corresponding to 0–3600.0s). It is 

readable and writable. 

When inverter ACC time 1 is set to a value 

rather than 0 through the PLC card, ACC 

time 1 specified by the value is forcibly used 

(P00.11 is invalid). When inverter ACC time 

1 is set to 0 through the PLC card, ACC time 

1 (P00.11) set through the inverter keypad is 
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used. 

C_DEC1 D7610 / 

0–36000 (corresponding to 0–3600.0s). It is 

readable and writable. 

When inverter DEC time 1 is set to a value 

rather than 0 through the PLC card, DEC 

time 1 specified by the value is forcibly used 

(P00.12 is invalid). When inverter DEC time 

1 is set to 0 through the PLC card, DEC time 

1 (P00.12) set through the inverter keypad is 

used. 

C_P_Err D7611 / 

PLC card user-defined fault. It is readable 

and writable. 

0: No fault (fault cleared) 

1: PLC card user-defined fault 1 

2: PLC card user-defined fault 2 

3: PLC card user-defined fault 3 

4: PLC card user-defined fault 4 

5: PLC card user-defined fault 5 

6: PLC card user-defined fault 6 

7: PLC card user-defined fault 7 

8: PLC card user-defined fault 8 

9: PLC card user-defined fault 9 

10: PLC card user-defined fault 10 

The C_P_Err fault code ranges from 1 to 10. 

A fault code greater than 10 is invalid. 

C_PID_GV_S D7612 / 

-1000–1000 (corresponding to 

-100.0–100.0%). It is readable and writable. 

To enable the PLC card to set the inverter 

PID reference value, set P00.00 to a value 

rather than 2, P00.06=7 and P09.00=11. 

C_PID_FB_S D7613 / 

-1000–1000 (corresponding to 

-100.0–100.0%). It is readable and writable. 

To enable the PLC card to set the inverter 

PID feedback value, set P00.00 to a value 

rather than 2, P00.06=7 and P09.02=9. 

C_MoP1 D7614 P27.12 
MoP1 value monitored by the inverter. It is 

readable and writable. 

C_MoP2 D7615 P27.13 MoP2 value monitored by the inverter. It is 
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readable and writable. 

C_MoP3 D7616 P27.14 
MoP3 value monitored by the inverter. It is 

readable and writable. 

C_MoP4 D7617 P27.15 
MoP4 value monitored by the inverter. It is 

readable and writable. 

C_MoP5 D7618 P27.16 
MoP5 value monitored by the inverter. It is 

readable and writable. 

C_MoP6 D7619 P27.17 
MoP6 value monitored by the inverter. It is 

readable and writable. 

C_MoP7 D7620 P27.18 
MoP7 value monitored by the inverter. It is 

readable and writable. 

C_MoP8 D7621 P27.19 
MoP8 value monitored by the inverter. It is 

readable and writable. 

C_MoP9 D7622 P27.20 
MoP9 value monitored by the inverter. It is 

readable and writable. 

C_MoP10 D7623 P27.21 
MoP10 value monitored by the inverter. It is 

readable and writable. 

C_VF_SET D7624 / 

0–1000 (corresponding to 0–100.0%). It is 

readable and writable. 

To enable the PLC card to set the inverter 

VF voltage, set P04.00=5 (user-defined V/F) 

and P04.27=12. 

C_UP_FRQ D7625 / Frequency upper limit. Reserved. 

C_SetDo D7626 / 

C_SetDo is an unsigned 16-bit number, 

which is readable and writable. 

Each bit represents a unique digital output 

terminal of the inverter: 

Bit0: Y1 

Bit1: HDO (for digital output) 

Bit2: Y2 (Inverter I/O expansion card output 

terminal Y2) 

Bit3: RO1 

Bit4: RO2 

Bit5: RO3 (Inverter I/O expansion card 

output terminal RO3) 

Bit6: RO4 (Inverter I/O expansion card 

output terminal RO4) 

Bit7–Bit15: Reserved 
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C_SetAO1 D7627 / 

0.00–10.00V/0.00–20.00mA. It is readable 

and writable. 

Inverter analog output terminal AO1, 

corresponding to -1000–1000/0–1000 

C_SetAO2 D7628 / 

0.00–10.00V/0.00–20.00mA. It is readable 

and writable. 

Inverter I/O expansion card analog output 

terminal AO2, corresponding to 

-1000–1000/0–1000 

C_SetAO3 D7629 / Reserved. 

C_RunStopState D7630 P27.11 

It displays the current running status of the 

PLC card. It is read only. 

0: Stopped 

1: Running 

C_DiState D7631 P27.22 

0x00–0x3F. It is read only. 

PLC card digital input terminal status. 

Bit5–Bit0 represent PS6–PS1 respectively. 

C_DoState D7632 P27.23 

0x0–0x3. It is read only. 

PLC card digital output terminal status. Bit0 

represents PRO1, and Bit1 represents 

PRO2. 

C_Ai1Val D7633 P27.24 

0–10.00V/0.00–20.00mA. It is read only. 

To use the PLC card input terminal AI1, you 

need to SM172, SM173, and SM174. After 

the setting, the input value (corresponding to 

0–10000/0–10000) of the PLC card input 

terminal AI1 can be read from SD172 or 

D7633(C_Ai1Val). The value is also 

synchronized to P27.24. 

For SM172, the value 1 indicates enabling 

input, while the default value 0 indicates 

disabling input. 

For SM174, the value 1 indicates current 

input, while the default value 0 indicates 

voltage input. 

SD173 specifies the sampling count. 

C_Ao1Val D7634 P27.25 
0–10.00V/0.00–20.00mA. It is readable and 

writable. 
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To use the PLC card input terminal AO1, you 

need to SM178 and SM179. After the 

setting, a value (corresponding to 

0–10000/0–10000) can be written to SD178 

to enable AO1 to output current or voltage. 

The value is also synchronized to P27.25. 

For SM178, the value 1 indicates enabling 

output, while the default value 0 indicates 

disabling output. 

For SM179, the value 1 indicates current 

output, while the default value 0 indicates 

voltage output. 

Note: D7634(C_Ao1Val) only has the 

display function and cannot be used for 

programming. That is, writing a value to 

D7634(C_Ao1Val) does not change the 

output value of AO1. 

C_Reserve5 D7635 / Reserved 

C_WrRece_PZD1 D7636 / CW sent to the inverter 

C_WrRece_PZD2 D7637 / PZD2 sent to the inverter 

C_WrRece_PZD3 D7638 / PZD3 sent to the inverter 

C_WrRece_PZD4 D7639 / PZD4 sent to the inverter 

C_WrRece_PZD5 D7640 / PZD5 sent to the inverter 

C_WrRece_PZD6 D7641 / PZD6 sent to the inverter 

C_WrRece_PZD7 D7642 / PZD7 sent to the inverter 

C_WrRece_PZD8 D7643 / PZD8 sent to the inverter 

C_WrRece_PZD9 D7644 / PZD9 sent to the inverter 

C_WrRece_PZD10 D7645 / PZD10 sent to the inverter 

C_WrRece_PZD11 D7646 / PZD11 sent to the inverter 

C_WrRece_PZD12 D7647 / PZD12 sent to the inverter 

C_RdRece_PZD1 D7648 / SW sent to the DP/CANopen/PN card 

C_RdRece_PZD2 D7649 / PZD2 sent to the DP/CANopen/PN card 

C_RdRece_PZD3 D7650 / PZD3 sent to the DP/CANopen/PN card 

C_RdRece_PZD4 D7651 / PZD4 sent to the DP/CANopen/PN card 

C_RdRece_PZD5 D7652 / PZD5 sent to the DP/CANopen/PN card 

C_RdRece_PZD6 D7653 / PZD6 sent to the DP/CANopen/PN card 

C_RdRece_PZD7 D7654 / PZD7 sent to the DP/CANopen/PN card 
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C_RdRece_PZD8 D7655 / PZD8 sent to the DP/CANopen/PN card 

C_RdRece_PZD9 D7656 / PZD9 sent to the DP/CANopen/PN card 

C_RdRece_PZD10 D7657 / PZD10 sent to the DP/CANopen/PN card 

C_RdRece_PZD11 D7658 / PZD11 sent to the DP/CANopen/PN card 

C_RdRece_PZD12 D7659 / PZD12 sent to the DP/CANopen/PN card 

C_Reserve6–41 
D7660–D76

95 
/ Reserved 
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Function 

code 
Function name Description Default Modify 

P27.00 PLC card enable 

0~1 

Indicates whether to enable the PLC 

card function, which is reserved. 

0 ◎ 

P27.01 I_WrP1 

0~65535 

Value that the inverter writes to WrP1 on 

the PLC card. 

0 ○ 

P27.02 I_WrP2 

0~65535 

Value that the inverter writes to WrP2 on 

the PLC card. 

0 ○ 

P27.03 I_WrP3 

0~65535 

Value that the inverter writes to WrP3 on 

the PLC card. 

0 ○ 

P27.04 I_WrP4 

0~65535 

Value that the inverter writes to WrP4 on 

the PLC card. 

0 ○ 

P27.05 I_WrP5 

0~65535 

Value that the inverter writes to WrP5 on 

the PLC card. 

0 ○ 

P27.06 I_WrP6 

0~65535 

Value that the inverter writes to WrP6 on 

the PLC card. 

0 ○ 

P27.07 I_WrP7 

0~65535 

Value that the inverter writes to WrP7 on 

the PLC card. 

0 ○ 

P27.08 I_WrP8 

0~65535 

Value that the inverter writes to WrP8 on 

the PLC card. 

0 ○ 

P27.09 I_WrP9 

0~65535 

Value that the inverter writes to WrP9 on 

the PLC card. 

0 ○ 

P27.10 I_WrP10 

0~65535 

Value that the inverter writes to WrP10 

on the PLC card. 

0 ○ 

P27.11 
PLC card current 

status 

0~1 

It displays the current status of the PLC 

card. It is read only. 

0: Stopped 

0 ● 



HD2-E-PLC Auto Station Software  Appendix 2 

-56- 

Function 

code 
Function name Description Default Modify 

1: Running  

P27.12 C_MoP1 
0~65535 

MoP1 value monitored by the inverter. 
0 ● 

P27.13 C_MoP2 
0~65535 

MoP2 value monitored by the inverter. 
0 ● 

P27.14 C_MoP3 
0~65535 

MoP3 value monitored by the inverter. 
0 ● 

P27.15 C_MoP4 
0~65535 

MoP4 value monitored by the inverter. 
0 ● 

P27.16 C_MoP5 
0~65535 

MoP5 value monitored by the inverter. 
0 ● 

P27.17 C_MoP6 
0~65535 

MoP6 value monitored by the inverter. 
0 ● 

P27.18 C_MoP7 
0~65535 

MoP7 value monitored by the inverter. 
0 ● 

P27.19 C_MoP8 
0~65535 

MoP8 value monitored by the inverter. 
0 ● 

P27.20 C_MoP9 
0~65535 

MoP9 value monitored by the inverter. 
0 ● 

P27.21 C_MoP10 
0~65535 

MoP10 value monitored by the inverter. 
0 ● 

P27.22 

PLC card digital 

input terminal 

status 

0x00~0x3F 

PLC card digital input terminal status. 

Bit5–Bit0 represent PS6–PS1 

respectively. 

0x00 ● 

P27.23 

PLC card digital 

output terminal 

status 

0x0~0x3 

PLC card digital output terminal status. 

Bit0 represents PRO1, and Bit1 

represents PRO2. 

0x00 ● 

P27.24 PLC card AI1 

0~10.00V/0.00~20.00mA 

The Value of PLC card input terminal 

AI1. 

0 ● 

P27.25 PLC card AO1 

0~10.00V/0.00~20.00mA 

The Value of PLC card output terminal 

AI1. 

0 ● 

P27.26 

Length of data 

sent from the 

PLC card and 

0x00–0x28 

Ones place: Quantity of data sent from 

the programmable card and inverter (that 

0x03 ○ 
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PZD 

communication 

object 

is, quantity of data sent from the 

programmable card + from inverter 

sending table 1 + from inverter sending 

table 2) 

0: 0+24+60 

1: 12+24+60 

2: 24+24+60 

3: 36+24+60 

4: 48+24+60 

5: 60+48+60 

6: 72+24+60 

7: 84+24+60 

8: 96+96+96 

Tens place: Card that communicates 

with the programmable card through 

PZD (valid only when the ones place of 

P27.26 is 5) 

0: DP card 

1: CANopen card 

2: PN card 

Note: P27.26 can be changed at any 

time, but the change takes effect only 

after re-power on. 
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